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Introduce

NOTICE
 ■ This manual is a common instruction manual for LE-650H2 / LE-650H2-A.
Since the operation method and screen are almost the same, they are explained by the same 
screen.

 ■ It is strictly prohibited to reprint or reproduce all or part of the contents of this manual without 
our permission.

 ■ The contents of this manual and the use of the product are subject to change without notice.
 ■ The contents of this manual have been prepared with the utmost care, but if you find any 
mistakes or omissions, please contact us.

 ■ Please note that we are not liable for any damages, lost profits, or any claims made by a third 
party due to the use of this product.

 ■ The image of this manual may be difficult to see due to its size. For details of the image, refer 
to the online help (or the pdf file of the attached CD).

USER LIMITATION
This product has been developed for the purpose of using as an analyzer only, and has not been 
developed for the use that needs exclusively high reliability and safety; aerospace apparatus, 
trunk communication apparatus, nuclear control apparatus, medical apparatus related with life 
maintenance and etc. Also, this product does not warrant the use for those purposes. If you use for 
those purposes, please consider the safety measures against fail-safe etc. on your responsibility.

Before Using the Product

Thank you for your purchase of USB Protocol Analyzer LE-650H2/LE-650H2-A.
Please read the operating instruction carefully before use to ensure safe operation of LE-650H2/
LE-650H2-A.
Please be sure to save this Manual. 
After installing the online help, you can use it from the software menu "Help" (or click the " " 
icon).
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Safety Information

Read this first ! !
Please read the operating instruction carefully before use to ensure safe operation of LE-650H2/LE-
650H2-A. The general safety rules are provided for your benefit to protect you and those around you.
Please read and follow them to avoid unnecessary injury and damage to the product and property 
and touse LE-650H2/LE-650H2-A right and safely.
Before you use this LE-650H2/LE-650H2-A, please familiarize yourself with the contents 
(symbols,marks) provided below.

[Explanation of the symbols (The degree of the hazard factor)]

The symbol denotes that improper handling poses a risk of causing death or serious injury.

"The symbol denotes that improper handling poses a risk of causing injury or damage to the 
product and property."

*"Injury" indicates injury, burn, an electric shock, or the like which does not require hospitalization or the extend over a long 
period ofhospital visit.

*"Damage to the product and property" indicates damage expansion related to a house, a building, furniture, apparatus, livestock or apet.

[ Explanation of the figure marks(concrete detail) ]

Indicates prohibition (things that you must not do)

Indicates comslsion (things that you must do)

WARNING
*Stop using LE-650H2/LE-650H2-A immediately when smoke or smells emanate from 

LE-650H2/LE-650H2-A.The continuous use may result in an electric shock, a burn and/or fire.

*Do not disassemble, modification or repair LE-650H2/LE-650H2-A Failure to observe 
this may result in injury, an electric shock, fire and/or a breakdown due tooverheating.

*Do not throw LE-650H2/LE-650H2-A into a fire, or expose to heat. Failure to observe 
this may result in fire, fire due to explosion and/or injury.

*Do not use LE-650H2/LE-650H2-A if any form of liquid or foreign matter entered LE-
650H2/LE-650H2-A .
Failure to observe this may result in an electric shock and/or fire.

*Do not use in the place which generates inflammable gas etc.This may result fire.
Keep the products away from water.Failure to do so may result in the heat generation, 
an electric shock and/or unit malfunction.

CAUTION

Do not place LE-650H2/LE-650H2-A in the following places. Failure to observe this 
may result in overheating, a burn, an electric shock and/or breakdown.
■a place where strong magnetic field and static electricity are generated, a dusty place
■The places with the humidity and temperature exceeding the tolerance level, and with 

a rapid temperature change.
■a place where unstable place and vibration are generated
■a place exposed to direct sunlight, a circumference of fire or the place where it is filled with heat
■a place with danger of the electric leak and water leak

WARNING

CAUTION
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Software License Agreement

This is a legal agreement between you, the end user, and LINEEYE CO., LTD.(LINEEYE). 
Carefully read all the terms and conditions of this agreement prior to use the software program 
or attached document. You are consenting to be bound by and are becoming a party to this 
agreement.

1 Copyright
The rights and copyrights of the SOFTWARE are owned by LINEEYE.

2 Grant of License
LINEEYE grants to you this software can be used on only one computer when you get this 
software and agree to our License agreement. Therefore, you may not transfer, rent lease and loan 
to third parties.

3 Copy / Analysis / Modification
This license does not allow you to copy, analyze or modify the whole or any part of the material 
except for the case that it is prescribed in the installation manual.

4 Upgrade
This software may be upgraded without a advance notice because of technical progress of 
hardware or software. LINEEYE provides software upgrades by payment for upgrade. For 
upgrade, it is granted only to the agreed License Agreement owner of this software.

5 Limitation of Liability
In no event shall LINEEYE be liable for any direct or indirect damages, special or consequential 
damages resulting from the use or in way related to the use of the software. Besides in no event 
shall LINEEYE be liable for damages resulting from equipments or mediums.

6 General
If any provision of this agreement is invalid, such provision shall be removed from this License 
Agreement.

7 Support
LINEEYE will support only to the problems are caused by this software or functions and 
operation of this software.

8 Others
The articles are not mentioned in this agreement, conform to the copyright laws and the other 
related laws.

LINEEYE CO., LTD.
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System Requirement

●PC 
  ・PC/AT compatible. CPU:Core 2 Duo or later (Core i series or later recommended). Memory:1GByte or more
  ・A USB 2.0 port can be used.

●HDD
  ・30MByte free space is required to install the software.
  ・In addition to the above, a log data recording area is required.

●Display resolution
  ・1024 x 768 pixel or more is recommended.

●OS
  ・Windows® 7 (32-bit / 64-bit) / 8.1 (32-bit / 64-bit) / 10 (32-bit / 64-bit)

Composition
Please check whether the following have gathered at the time of delivery of goods.

< LE-650H2/ LE-650H2-A>
    ●USB Analyzer : 1
    ●USB cable (with A-B plug 1.8m/0.9m) : 2
    ●CD-ROM (LE-650H2 software) : 1
    ●Installation manual : 1
    ●Warranty/Customer registration card : 1

If any item lacks, please contact the distributor where you purchased the product or us.

Outline
LE-650H2/LE-650H2-A is apparatus which connects with a PC, and analyzes "USB Protocol". 
"USB Protocol" is recorded on the hard disk of PC on real time, and it is displayed intelligibly for 
a LE-650H2/LE-650H2-A Software window.

●HIGH/FULL/LOW speed modes automatic identification
The device speed to observe is judged automatically.

●Continuous record a max.10Gbyte (Max. 40Gbyte for LE-650H2-A)
Monitored USB data is recorded up to 10Gbyte into the PC hard disk drive. And the screen 
can be also scrolled during analysis. It is effective in the analysis of the unspecified trouble 
which rarely happens.

●Intelligible Display
“Packets” in monitored data is intelligibly displayed per “Transaction”.
“Standard device request” and “Descriptor” are translated in detail.

●Trigger function linking with other measuring instruments
It is possible to specify up to 16 sets of trigger which can execute the actions in sequence. 
When receiving error or specific packets, you can select start and stop of measurement or 
trigger output which is effective to link with other measuring instruments.

●Upgraded Off-Line Analysis Capability
It is easy to find data which you are interested in from enormous recorded measurement data by 
filtering. To learn more about details, please refer to the online help.functions and Find functions.
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1.　Explanation of each part
< LE-650H2 / LE-650H2-A >

1.　USB connector for analysis PC Connect to an analysis PC with the attached cable.
2.　USB device connector Connect to a USB device to be measured.
3.　USB host connector Connect to a USB host to be measured.
4.　External trigger connector External trigger input / output port 10-pin connector * 1

5.　POWER/RUN Lit in green: The Power is ON and in measurement-
standby state
Lit in red: In measurement
Blink in orange: Overflow occurred
When the buffer memory inside the main unit is full * 2

6.　VBUS Indicates the voltage level of VBUS.
Lit in green: Approximately 4.5V or higher
Off: Less than about 4.5V

7.　DATA Indicates the data communication status between 
the measurement target USB host and the device.
Lit in green: When transferring data between the 
USB host and the device
Lit in red: The USB bus status is "BUS RESET"
Lit in orange: SUSPEND

8.　SPEED   H/F/L The speed of the USB device being measured (Hi-
Speed / Full-Speed /Low-Speed) is shown.
Lit in green: Full-Speed
Lit in red: Hi-Speed
Off: Low-Speed

* 1 An optional 5-wire probe cable (model number LE-5LP2) can be used.
* 2 When it lights in orange, it stays in orange even after a free space is made in the internal memory.

① ③

②

④

⑤⑥⑦⑧
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2.　Installation of software and drivers

2-1.　Installation of PC soft and USB Driver (Windows7/8.1/10)
Insert the attachment CD-ROM into the CD-ROM Drive of PC.
Then, the installer automatically starts. If it does not start automatically, click "setup.exe" on the CD-ROM.

Attention: Please install the software before connecting the analyzer.

The driver will be available when connecting the analyzer to 
the PC at the first time after installing the software.

4.Click “Next” to continue. If you would like to 
select a different folder, click Browse.

5.The license key will automatically appear when 
“Verifying license key” dialog is displayed. Then 
click “Next” to continue.

*In case of installing the trial version, click 
“Next” without filling the blank.

1. The setup dialog box appears. To start the setup 
wizard, click "Yes."

2.Click “Next”, when following setup dialog is 
displayed.

3.Confirmation of Software licence agreement 
and MTP(Media Transfer Protocol) licence 
of Microsoft are displayed .To use these 
functions of MTP, you need to accept the license 
agreements and click “Next”.
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9.Click [Next] when starting the installation of the 
device driver.

10.Click “Install” , when the following dialog is 
displayed.

11.When the following dialog is displayed, the 
installation of driver has been done. Click [Finish].

12 .Installation of software will be started. When 
the set-up wizard is completed, the installation 
is finished. Click [Finish].

6.Click “Next” to continue. If you would like to 
select a different folder, click Browse.

7.Select the additional tasks which you would 
like Setup toperform, then click “Next”.

8.Click “Install” to continue with the installation.
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2-2.　Installation to PC via LAN
You can install the software to the PC which does not have a CD drive via LAN, using another 
PC with a CD drive.
*You can also install it using an external CD drive, but here we will explain other methods.

1.Insert the CD to the PC with a CD drive.

2.Set the property of the CD drive to access from the PC without the CD drive (for more information, 
please consult your network administrator).

The PC for installation without a CD drive

LAN

The PC with a CD drive

Insert the CD

LAN

Copy setup.exe.

The PC for installation without a CD drive The PC with a CD drive

3.Copy “setup.exe(v1.0.0.2 or above)” to the appropriate folder in the PC without the CD drive.

*If you have the CD which version is v1.0.0.1 or below, install the latest software from 
LINEEYE web-page.
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4.Execute “setup.exe” in the PC with the CD drive. Then proceed the process until “The USB 
Protocol Analyzer LE-650H2 setup wizard” appears.

5.Execute the “setup.exe” from the PC without the CD drive. The license key number is automatically 
filled and then complete the setup wizard.

The PC for installation without a CD drive The PC with a CD drive

LAN

Execute setup.
exe.

The PC for installation without a CD drive The PC with a CD drive

LAN

Execute setup.
exe.
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6.After finishing the installation at (5), cancel the setup wizard started at (4).

LAN

The PC for installation without a CD drive The PC with a CD drive

2-3.　About Version Up
The latest version of monitoring software can be used by downloading it from our website. 
However, it requires a “license”to use new functions which are added later than about 1 year after 
your purchase of the product.
Note: Bug fixing can be updated without this limitation.
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3.　Connection

3-1.　Basic connection
USB protocol analyzer LE-650H2 / LE-650H2-A displays and records the captured log on a PC.
This PC used for displaying and recording is called "Analysis PC."

The host PC for USB protocol analyzer needs to have a USB interface supporting USB2.0 High-
Speed.

Connect the USB connector on the back of USB protocol analyzer LE-650H2/LE-650H2-A to the 
USB port on analysis PC by using the USB2.0 High-Speed (Certified) cable as the figure below 
shows.

＜ Notes on connection with analysis PC ＞

The connection with the analysis PC must be made by USB2.0 Hi-Speed. Please note that it 
will not work when connected at Full-Speed caused by such as the use of poor quality USB 
cable.

When the setting in the Windows power management has an option such as putting the system 
to sleep when the operation is not performed for a certain period of time and the option is 
abled, "The error occurred while transferring the log data.Log operation has been stopped." 
message may appear during measurement and the measurement may be stopped. To avoid this, 
if there is such a setting, please disable it. 

Personal computer for analysis

  USB 2.0 Interface

 USB device  USB host PC

Hi-Speed
Full-Speed
Low-Speed
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3-2.　Notes on the USB cables

●Use the cable which has attested all USB2.0 standards for the USB connection. All must use the 
USB2.0 standard certified cable to connect USB.  

●Follow the conditions below such as the length of the USB cable.

Connecting LE-650H2 / LE-650H2-A to the USB protocol analyzer host PC 
・Use One USB2.0 standard certified cable 5m or shorter.
・Do not use a hub or extension cable on the way.

Connection with the measurement targets
・Make a TAP connection to the analyzer as shown in the figure using the attached shorter USB 
cable and the USB cable which was used to connect the devices to be measured.
・Keep the total length of the two cables as short as possible.(3m or less recommended)

Personal computer for analysis

    USB 2.0 certified 
    cable 5m or less

 USB device  USB host PC

Hi-Speed
Full-Speed
Low-Speed
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4.　Basic operation

1.Connect the analysis computer and LE-650H2 / LE-650H2-A with the included USB cable.
For the detail see "3. Connection" on page 12.

2.The analysis software automatically detects that the LE-650H2 / LE-650H2-A is connected and 
initializes the LE-650H2 / LE-650H2-A hardware. You can start measurement after when the 
POWER / RUN LED of LE-650H2 / LE-650H2-A lights up in green.

3.Set the analysis software.
Start the software and select "Options" "Connection port" from "Log" in the menu.
The dialog shown below appears.
Select the serial number (LE-650H2) / serial number (LE-650H2-A) from the "Connection 
method" list.

This setting is required only when you run the analysis software for the first time.

4.Connect the USB host and USB device which you want to measure to LE-650H2 / LE-
650H2-A.

* We recommend you to connect only the USB device for which you want to acquire logs, and 
do not connect other USB devices.
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5.　Press the space key or the "Log start" button to start the measurement.

6.　While saving the data from the first USB packet found to the HDD / SSD of the analysis PC, 
it displays it on the screen with an easy-to-understand transaction unit. The analysis software 
can scroll the data display even during the measurement.

< Example of measurement>

7.When you finish the analysis/measurement, press the space key or the "Stop" button to finish 
the measurement.

* If a large amount of data is measured, it may take several minutes after stopping.

8. If necessary, use the display filter and search function to perform analysis.
（You can quickly search and display the communication data you want to see.）

9.If you want to save the measured data, save the log to a file.
* If you want to extract only the necessary communication data part to organize and save it, 

click "New" from the "File" menu to create a new log window, and use the "Copy" and 
"Paste" functions to paste and put it together to this new log window.



16

5.　The display screen
5-1.　Explanation of Packet Display 

①：VBus measurement bar　The power (W), voltage (V), and current (mA) of the BUS line 
being measured are measured and displayed.

②：Displays plural packets as a transaction in one line.
③：Display SOF (Start of Frame). In the High-Speed device,the micro frame is displayed as "(1/8)" - "(8/8)".

Because a Low-Speed device does not generate SOF packets , nothing appears in this column.
④：Displays token packets . (Token type / Address / End point)
⑤：It shows the first 8 bytes of the data packet and the total number of data. Click "+" to display 

all data. Each data is displayed in ASCII on the right side.
Hover your mouse over this part to see the contents of the packet including the CRC value.

⑥：Displays handshake packets. You can also display all the transactions that repeat in the display filter settings.
⑦：Displays elapsed time. 
⑧： Displays the USB bus state.  

・BUS RESET ：Displays when the USB bus reset is issued.
・SUSPEND  ：Mainly displays when communications with devices stop.
・DISCONNECT ：Mainly displays when the USB device is disconnected.
・DEVICE-CHIRP ：It is displayed when device chirp is detected.
・DISCONNECT ：It is displayed when hub chirp is detected.

⑨：Marks the user-defined transactions from 1 to 99. 
⑩：Display the communication speed for each transaction.

e.g.)「 HIGH： 」/「FULL： 」/「LOW： 」 
⑪：Highlights transaction which you select with a mouse.
⑫： If you check "Record VBus voltage/current with USB log" in the log operation settings, the 

VBus voltage / current log will be recorded by the selected cycle. 

①

⑪

⑧

⑩

⑦④③

②

⑥⑤⑨

⑫
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＜ Mark and meaning ＞

Mark Meaning
Indicates that there was a CRC error.

Indicates a transaction which contains a PRE (preamble).

Indicates SSPRIT (start SPLIT).

Indicates CSPLIT (Complete SPRIT).

unknown If there is a packet ID (PID) that is not defined in the USB 2.0 standard,
Displayed when the packet ID is normal but the packet length is unreasonably short (or long)

5-2.　Detailed display of request / descriptor by class　

If there is a transaction which begins from the "SETUP" packet as shown in a figure, a "request 
type"  and the mark will be displayed on the right side.

  Device request details window" like the right opens when  mark is clicked with the mouse, and      
  information on request Descriptor is displayed in the shape of the tree. 

　<Types of device requests supported>
　・Standard device request 
　・HUB Class-Specific device request 
　・HID Class-Specific device request 
　・Audio Class-Specific device request 
　・Communication Class-Specific device request
　・MassStorage/Bulk Only Transport-Specific device request 
　・Printer Class-Specific device request  
　・USBTMC Class-Specific device request 
　・Video Class-Specific device request
　・Wireless controller Class-Specific device request

*only for HCI protocol for Bluetooth dongle

<Types of descriptors supported>
　・Standard descriptor 
　・HUB Class-Specific descriptor 
　・HID Class-Specific descriptor 
　・Audio Class-Specific descriptor 
　・Communication Class-Specific descriptor 
　・Video Class-Specific descriptor

* The USB protocol analyzer software searches the 
log data for GET_DESCRIPTOR requests in order 
to identify the class / subclass to which the target 
device request belongs. Therefore, if the GET_
DESCRIPTOR request related to the Configuration 
descriptor does not exist in the same log data, it 
may be displayed as "Undefind" because the class to 
which it belongs cannot be identified. In this case, 
specify the class in "Device Class Setting". However, 
device classes which the USB protocol analyzer 
LE-650H2 / LE-650H2-A does not support will be 
displayed as "Undefind".

* By clicking the arrow on the upper right of the request 
details display window, you can display the previous 
and next device request details. You can adjust the 
density of the device request details window by 
sliding the knob on the slide bar on the right side.
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5-3.　How to set the screen display
You can set and change the screen display as you like.

＜ Operating procedure ＞

1．Click "Display Filter / Color" from the [Display] menu.

*The above figure is the screen when the font is set.

2．The following items can be changed in the "Filter&color setting" dialog.
Refer to the "Display image" at the bottom and make the settings as necessary.

・Filter
By this function, you can check only necessary data and hide other packets and 
transactions. 
(See "● Display Filtering Function"　for the detail)

・Font
By this function,you can change the display font and font size.

・Color 
This specific characters and background color of each packet.

・Advanced settings
This makes it possible to change the open methods for the device-request details window.

3．After entering the settings, press "OK" to confirm.

* If you check "Set as Default" when you press "OK" to confirm, this setting will be 
reflected in the newly opened log windows after it.

<Commands specific to the supported device class>
　・Mass Storage / Bulk Only Transport commands
　・USBTMC class commands
　・Operations, Responses, and events of MTP/PTP
　・Bluetooth dongle HCI protocol commands and events
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　●Display Filtering Function
This function displays only the applicable transactions on specific conditions. This function 
makes it possible to quickly verify only the desired packets/transactions without displaying 
unnecessary packets/transactions.

＜ Display filtering conditions ＞

Hide SOF packets (*)
Hides the SOF packet.When capturing data from the Low-Speed 
device only, those settings are not required because it does not 
generate SOF packets.

Display the repeatability 
NAK transactions 
collectively.

When the NAK responses, such as "IN-NAK transaction," the "OUT-
NAK transaction", etc., have occurred continuously, those transactions 
are collectively indicated by the number of times. For example, "x13" 
means to receive the same transactions 13 times in a row.

Display SETUP
 transactions only Displays the transactions only including SETUP.

Hide PING transactions Hides the states of waiting transmission, in the bulk transfer of 
HS device (PING token -> NAK handshaking)(LE-650H2only).

Hide IN-NAK 
transactions

Hides the states with no transmission, mainly in bulk transfer/
interrupt (In token -> NAK handshaking).

Hide OUT-NAK/SETUP-
NAK transactions

Hides invalid transmission data, mainly in bulk transfer 
(OUT token -> DATA packet -> NAK handshaking).

　●USB address / endpoint
To perform filtering according to the USB address/end point number, select the conditions 
from the group box of "USB address / end point."
This displays only the specified address/end point. Input address/end point as follows.

＜ Input value example ＞

Input method Input value
When setting only one 1
When setting  the plural (separates by comma) 1,3,5
When setting the plural continuously (hyphenation) 1-5

Click "Advanced" button to set separately.

The "Display Filtering Function" temporarily hides a specific transaction from the screen or print 
but does not delete the hidden transactions from the log.
Therefore, even when the log data in the file is saved under the display filtering condition, all the 
log data is saved in the file, including the temporarily-hidden transactions.

Note：Because the display structure is assembled again according to the filter setting when the condition 
of the display filtering is changed, it might take time until all the transactions are displayed when 
the amount of the log data is large.
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6.　Log settings and save
6-1.　Log operation settings

　You can configure the following settings by clicking "Options" from the "Log" menu.
　　・Selection of USB port to connect the analyzer
　　・Detailed settings for log operation
　　・Specifying a temporary folder and setting regarding how to check the free space

＜ Operation method ＞
1.　Connection port setting

Select either the serial number (LE-650H2) or the serial number (LE-650H2-A) from the drop-down list.
2.　Log operation setup

Item Meaning・Function

When the hardware 
buffer becomes full

Stop log operation at once 
The log operation stops when the buffer memory is full (default setting).

Continue log opperation as much as possible
When the buffer memory is full packets are discarded. When the buffer memory have 
space again subsequent recording is resumed, but since the packets were discarded 
when the buffer memory was full, the transaction structure may not be correct.

Data logging place 
of log operation 
start

Add to the log window opened now
Add new log data to the end of the current log and record it.

Open and record in a new log window
Open a new log window and log to it.

Clear the present log window and record newly
Erases all data recorded in the current log window and records a new log.

Limitation of log 
data size

Log file size
When the specified log size is reached while logging, the logging operation is 
automatically stopped or writing to the next file is started.

Files in Repeat mode
Specify the number of files to open when acquiring logs in repeat mode.

Record VBus 
voltage/ current 
with USB log (*)

VBus voltage / current recording (*)

When checked, the VBus voltage and current are recorded at the selected cycle 
with the USB communication packet at the same time.

* This is a function after v1.3.0.0. It will not work on the analyzer whose license has expired.
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3.　Temporary folder
Set a temporary folder to temporarily save log data.
Select "Options"-> "Temporary Folder" from "Log" in the menu.

　

Use of a prearranged 
temporary folder 
in windows as the 
temporary folder

Use the Windows default temporary folder as the temporary folder.

Designate a 
temporary folder（*3）

(When the "Use of a prearranged temporary folder in windows as the 
temporary folder" check box is OFF)
Specify a temporary folder. Do not specify a non-existent folder or a network-
connected folder.
We recommend that as a temporary folder you specify a folder on the same 
drive as the drive where you want to save the log data .

Select a folder
(When the "Use of a prearranged temporary folder in windows as the 
temporary folder" check box is OFF)
Open a folder browser to select a temporary folder. Do not select CD, DVD 
drives or folders on the network.

Display a warning
If the free space of the temporary folder falls below the set value during log 
operation, a warning dialog appears but the logging operation continues as it is.
When the free space is completely exhausted, the log operation will stop 
automatically (* 1).

Stop data logging If the free space of the temporary folder falls below the set value during log 
operation, log operation stopps immediately (* 1) (* 2).

Assign the 
freecapacity

Set the limit value of the free space for "Display a warning" / "Stop data 
logging" in MByte units.

*1：There can be a slight lag before the warning is actually displayed or the log operation stops.
*2： Normally, use the setting with "Stop data logging". If the free space of the temporary folder becomes extremely small (several 

Mbytes or less), it may not be able to execute processing such as displaying, searching, and saving logs.
* 3: The specification of the temporary folder is applied to "the newly opened log window after the temporary folder is specified".

If the log is acquired for an already open log window, the temporary setting of when the log window is opened is used.
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6-2.　Saving a log file
To save the log data in the file, click "Save" or "Save As" from the File menu. Even if you start 
logging new data after saving data and try to close the window, the file save dialog appears. Name 
the file to save the updated data if needed.

Because it is not deleted from log data, a transaction hidden by "Display Filtering Function" is 
also saved in the file.

Note: If you want to narrow down and save only specific data,
Apply " Real Time Filter function * 1", "Trigger function * 2", "Edit(log file) * 3", etc.

　*1：Refer to "7-4. Real Time Filter"
　*2：Refer to "8. Trigger settings"
　*3：Open a new file and edit the necessary information with "Copy" and "Paste".

＜ Save format ＞

.usr USB protocol analyzer software packet file.
This is a file for saving main log and mark information.

.uvd

The transaction data base file that software uses when the log file opens again. The 
file helps short the processing time when you display the log again or change the 
display filter conditions. 
*Even if you delete the file, it will be created again by opening and closing the log 
data.

.vbl Log files for VBus Logger Mode 
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7.　Useful functions

7-1.　Retrieval Function 
You can retrieve a specific type of packets.

＜ How to use the retrieval function ＞
1.　Click "Find" from "Edit" menu to display the following dialog.

2.　Select the object which you want to retrieve from "find target".
* Refer to "USB address / endpoint" on page 19 for USB address / endpoint settings.

・"Transactions/Packets"
Retrieves by combining the token packet and the handshaking packet.

・"Data"
Retrieves the data character string.

・"Others"
Retrieves the SOF number and the error packet (CRC error/PID error).

・"Requests/Commands"
Retrieve each class/standard requests. Retrieve class commands.

3.　Click "Find previous" "Find next".
4.　Data that matches the search conditions will blink.

＜ Transactions/Packets retrieval ＞
Put the mouse pointer on the specific transaction at the data display, arrows appear above and 
below the transaction. To search transactions of same conditions (token, address, end point, 
handshake), click the arrow.
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7-2.　Mark Function 
Using "Mark Function", you can put sequential numbers on a transaction in the log.
For example, marks can be put at the point where the USB host controller identifies a new USB device and 
starts setting up, or at the point where the USB device starts a transmission. An arbitrary mark comment 
can be input to each mark, and the explanation can be added to analyzed content and transaction. 
It is convenient to use the "Mark Function" not only for view ability but also for jumping to the marked 
position "Jump Function" when analyzing the transactions.

When the mouse cursor is over the mark, the mark comment is displayed in pop up.
Moreover, the mark comment is displayed in the statusbar when jumping to the mark by "Jump function."

7-3.　Time Mark Function
Using "Time Mark function," you put the mark to two transactions, and can have the elapsed time between 
the transactions displayed. You can make the time mark by clicking the "elapsed time display" part of the 
transaction. Click the elapsed time column of another transaction.
The elapsed time between two marked transactions is displayed in the statusbar.

Mark

Mark's comment

Time mark
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7-4.　Real Time Filter
This function makes it possible to capture the necessary log data only onto host PC and to 
decrease the file size of the log data. 

＜ Operation procedure ＞

1：Click "Setup" from "Log" menu.  

2：Click "new entry" of "Real-time 
filtering settings" at the left side of 
"Setting for logging" dialog. 

3：Selects the transaction which includes 
addresses/endpoints to capture and 
token/handshake not to capture.

* Refer to "9-1. USB Device Class 
Setting" for USB address / 
endpoint settings.

4：To close "Detailed designation for USB address/endpoint" dialog, and go back to "Real-time 
filtering settings." 
If you want to change the item name of real-time filter which has been set, it is possible by 
right-clicking or F2 key.

5：Confirm that the left side of the item name of real-time filter you want to operate is checked, 
and click "OK." Captures logs when filter is effective after starting logging.

* : When restarting the application, real-time filter is null.
However, puts the check again when you want to use real-time filter, because the contents 
of the filter setting is stored. 

* : Note when setting the plural 
Only one setting of real time filter which is checked in the left side will be effective.

* : Cancellation and delete of the settings 
Remove the check at the left side of the item name to cancel temporarily leaving the 
settings.When you want to delete the settings, click the item name then delete by "Delete" 
key, or right-click on the item name then click "Delete." 
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7-5.　Repeat Mode
This function allows you to capture more than log data of 2GB, and to capture up to about 10GB 
(up to about 40GB for LE-650H2-A ). This mode lets log data go to from 2 and 5th (2 and 20th 
for LE-650H2-A ) log window in order as ring buffer. Then, when log data is over the set value, 
the existing log is deleted and the new log only is recorded. 

＜ Operation procedure ＞

1：Click "Setup" from the "Log" menu.

2：Click "Log operation setup" 
from the "Basic settings" at the 
left side of "Setting for logging" 
dialog.

3：In "Limitation of log data size" 
at the right side of "Setting 
for logging" dialog, inputs a 
maximum size of data per log file 
into "max" and inputs the number 
of the open files into "Files in 
Repeat mode. "The maximum 
size of log data per file is up to 
2GB, and the number of file to 
open is up to 5th (up to 20th for 
LE-650H2-A ). 

Also, set "Continue log operation  as much as possible" for "When the hardware buffer 
becomes full." If "Stop log operation at once" is selected, stops logging when the hardware 
buffer becomes full.

4：To close "Setting for logging" dialog, click "OK."

5：Select "Repeat mode Space" of "Start" from the "Log" menu. Or to select "Repeat mode" 
click the mark at the right side of log start at the tool bar.

6：On starting logging, the specified number of the files open and the log is captured as a ring 
buffer until the log stops.

7：After the log stops, you can analyze or save the necessary data in the opened log windows.
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8.　Trigger settings
・By using this feature, can perform log stop and trigger output from near the data which you want to confirm.
・The plural trigger condition and trigger operation are set beforehand, and the trigger 

condition can be judged one by one.

＜ Operation procedure ＞
1.Click "Setup" from "Log" menu.
2.Click "new entry" from "Sequential 

triggers" of "Trigger settings" at the 
left side of "Setting for logging."

3.Selects the method of trigger to set 
from Packet trigger, Error trigger, 
Bus state trigger 、External trigger, 
VBus trigger 
To set the plural, click each trigger 
buttons pressing "Ctrl." When 
setting the plural, each triggers 
operates by "OR." 

・Packet trigger
Log operation can be stopped and trigger output can be performed with the specified packet.

You can select the USB device address, endpoint, token packet / handshake packet, and 
configure the setting for the data-packet-match judgment.

・Error trigger
By using this feature, can perform log 
start and stop external logs from near 
the data which each error generated. 
Select the kind of the error to be target 
of the trigger operation from "CRC 
error" or "PID error".

・Bus state trigger
By using this feature, you can start and 
stop external logs and trigger output 
when the Bus State Trigger happens.
Select error type from "Bus Reset", 
"Suspend" and "Disconnect".

In case of Hexadecimal,Binary,Decimal
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・External trigger
External trigger I/O connection port 
on the back side of LE-650H2 / LE-
650H2-A allows you to start and 
stop external logs, and also it allows 
you to perform the signal output 
to the outside when the specific 
conditions are satisfied.

* For external triggers,  in the 
hardware settings, "Post trigger 
size (trigger position)", "External 
trigger input (selection of level 
edge)", "Output (selection of level 
pulse output)", and "initial state of 
the Output"  setting is necessary. 
Also, do not check the unused 
external trigger terminals as they 
are in an undefined status.

・VBus trigger
With this function, you can stop the 
logging or execute a trigger output 
by the VBus voltage/current value.

Configure the "Targetted range" 
with regard to the Voltage range and 
the Current range.
Blank the column which you will 
not use. When you set both the 
voltage and the current, the trigger 
will be generated by OR conditions.  

Click "Log operation setup" at the 
left side of "Setting for logging" 
dialog.
Put a check mark on "Record VBus 
voltage/current with USB log".

4.Selects the operation of "When 
trigger conditions match," from "Log 
start" or"Stop logging","Signal out."
When "Signal out" is selected, click 

 button at the right side.

Select the output port and its "High 
pulse" or "Low pulse", and then 
click [OK] to close the [Trigger 
outputs] dialog. 
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5.Leave the trigger conditions you want to use for logging of this time to "Sequential triggers", 
and drag and drop the item names of other trigger conditions to "Spare settings" folder icon.
Furthermore, to change sequence to judge the trigger conditions, replace　the item names in 
"Sequential triggers" folder by drag and drop. You can also change the priority of triggering. 
The trigger is executed from the upper item name.

Note ：When setting the plural
・Can set the trigger conditions and the trigger operation up to 16th. 
・Can set "Stop logging" only one each in "Sequential triggers" folder.

6.After completing the settings, click "OK" to store the settings.To change the item names 
such as "Trigger 1", click the item name and press "F2", or right-click on the item name and 
select "Rename."

Note：Stop the software once, and restart.
All the trigger setting conditions will move to "Spare settings" folder after stopping 
the software of LE-650H2/LE-650H2-A. 
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9.　Detailed analysis function

9-1.　USB Device Class Setting 
Even you do not have any emulation information in the log file, you can display translation 
information by setting "USB Device Class Setting".

＜ When only mono feature device ＞

1. Click "Device Class Setting" in the 
"Edit" dialog. 

2. Input address which you want to 
display translation information in the 
"Target USB Address".

3.Select the class for the address from 
"Device Class". 

4.Click "Add" in the "Endpoint List" and 
open the dialog for "Endpoint setup".

5.Select the end point number and direction, and click "OK". 

6.Check whether or not the setting in "5" is displayed in the end point list, and click the end point.

7.If there is something displayed in the "Endpoint Type", select 
the transmitting method.

8.Repeat "4" to "7", if you have more than one end points.

9.Click "Apply" and check whether or not the translation is 
displayed in the information Window.

10.Click "Close" and close the "Device Class Setting" Window. 

*You can save/load the settings of device 
class, interface and endpoint by clicking 
the "Save Setting" and "Load Setting" 
button.
Save/Load the settings will be operated 
for each USB address. If you want to save/
load the setting for multi USB address, 
you must save/load the settings for each 
address. 

*Set as "When only mono feature device", 
even if you have multi USB devices.
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9-2.　Statistical Information
This function helps statistically check data by totaling the following regarding the log: total 
transactions, transfer bytes, and transfer rate [bytes/sec].
Statistical Information of each address or each address/endpoint will be displayed.

＜ Operation ＞
1.Select the target area: "Entire transactions/packets" or "Selected."
2.Select the type: total transaction, transfer bytes, and transfer rate [bytes/sec].
3.Right-clicking each item of the packets selects each type of the packets to display or hide.
4.Clicking the update button during capturing the log shows the information updated at the point.
5.Clicking the head of the table, such as "IN," helps arrange data in ascending or descending order.
6.You can copy and paste those data to another application like Excel. At first, select the 

necessary range of data; second, copy it by pressing Ctrl and C keys; finally, paste it to another 
application.

9-3.　Operation Report Creation and Miscellaneous Items
The USB protocol analyzer software pastes log data to the text editor via the clipboard.

＜ Operation procedure ＞
1.Select the range of the data in the log window which you want to paste to the text editor with 

the mouse. To select the continuous/discontinuous range of data, click with the Shift or Ctrl key.
2.Click "Copy" from the Edit menu to set the range on the clipboard.
3.Paste it to the text editor. (Generally, press "Ctrl+V," or click "Paste" from the Edit menu.)

*You can "Drag-and-drop" to paste it, if the text editor supports the function.

*If you select and paste the large range of data to the text editor, an error may occur. In such a 
case, divide the range into several small parts and repeat "Copy" and "Paste" operation.
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10.　About the measurement of VBus value(Voltage(V),Current(mA),Power(W))

You can measure the VBus value (Voltage (V), Current (mA), Power (W)of the USB to be 
measured and display it in real time.

1.Click [Display] from the menu bar and mark on [VBus bar] to check the VBus value

2.VBus measurement is displayed as shown below.
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11.　VBus Logger mode
Measure VBus voltage, current, power consumption at the specified cycle, and display in graph.
Measured data can be saved at CSV format and pasted to the spreadsheet software.

* "VBus logger mode" is supported from software version v1.1.0.0.

＜ Operation ＞
1. To set VBus measurement setting, click [Log]-> [Set up]-> [VBus logger mode]. Specify 

the VBus sampling rate and enter the measurement time.
* In the VBus logger mode, "Log operation setup" in the "Log" menu is not applied.
* If you leave the measurement time blank, it will automatically stop when the recorded 

data reaches 2GB.(5 bytes are used for one sampling.)

2. Click [Log]-> [Start]-> [VBus logger mode]
(Or select [start --VBus logger mode] from the measurement start button) to start the VBus 

measurement.

model Sampling rate
LE-650H2 100msec , 200msec , 500msec,1sec
LE-650H2-A 0.1msec , 0.2msec , 0.5msec,1msec , 2msec , 5msec, 10msec , 

20msec , 50msec, 100msec , 200msec , 500msec,1sec
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3.VBus measurement data will be displayed and recorded.

4.Stop measurement.
 It stops measuring automatically when it passes the measurement period, or records 2GB of 

data. To stop measuring manually, press stop button or select [ Log ] --> [ Stop ] 

5.Log data can be saved and outputted as CSV file after the measurement.
  *You cannot select the range of data when outputting CSV file.

・Save logfile ( .vbl file)
 Select [ File ] --> [ Save as... ] to save logfile.

・csv output
 Select [ File ] --> [ Export ] --> [ in CSV form ] to output as CSV file.

Graph

Damp Data
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12.　OP-SB84 data conversion
The software of LE-650H2 can read the log file(file extension: DT) measured by OP-SB84, 
(the USB expansion board of LE-8200(A)), to display the data and save it as the log file of LE-
650H2 (file extension: usr). 
*If the data file contains both USB data and VBus measurement data, the file cannot be opened by LE-650H2 software. 

＜ Operation ＞
1.Open the log file(.DT)

Drag and Drop the log file(file extension: DT) to the main window of LE-650H2.
Or click [File]-> [Open...]. 

2.Display the data
Data is displayed on the window when opening the file.

Unique display on OP-SB84
OP-SB84 display After loading the data to the log LE-650H2

「RESET」
*No record during the reset period *Displays without record of the reset period. 

「VBUS OFF」
「Session end」
「Session valid」
「VBUS ON」

No record of the time of packet's end. Records the time of packet's end. * Dummy value 
Trigger No(0-7) Display as Trigger No(1-8)
A flag for matched trigger condition is displayed 
for each packet. 

A flag for matched trigger condition is displayed for 
each transaction. *If multipul flags are appeared, the 
lowest number is displayed.

Trigger log of external input is displayed in 
chronological order. 

If there is a trigger log of external input in the 
transaction, it is displayed after the transaction. 

「--Overrun--」
If incomplete packet information is recorded, fot 
exsample at the time of overruning data,incomplete 
data is displayed or not displayed anything.
If some of the data in the file is corrupt, it will not display.

3.Save the data
Click [File]-> [Save As...] to save the data as the log file (file extension: usr). 
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13.　Function / reference
Description of each function of the menu

Menu item Toolbar Shortcut key Function

New Ctrl+N Open a new log window.

Open... Ctrl+O Open a saved file.

Close Close a log window. If the log data needs to 
be saved to a file, the save dialog appears.

Save Ctrl+S
Save the log data under the current file 
name. If the file has no name, the save 
dialog appears.

Save as... Save the log data under a new name.

Export Ctrl+E Save in,Text format・CSV format・DATA 
packet:binary format or any format*1.

Print... Ctrl+P
Print out the log data.
Can print out only the selected area of 
the log data.

Print Preview Shows the print preview page.
Print Setup... Set up the printer.

Exit Alt+F4 Exit the USB protocol analyzer software.

Undo Ctrl+Z Undo the last paste.

Copy Ctrl+C Copy the log data selected in the log 
window to clipboard in the text format.

Paste Ctrl+V 
Paste some of the log data copied to 
clipboard at the end of the active log 
window.

Select all Ctrl+A Select all transactions displayed.

Invert selection Ctrl+I Invert the selected and non-selected 
transactions.

*1　Save as export. Exported data cannot be loaded into the USB protocol analyzer software again.

Text format When selecting "Text format", it will save the data in almost same format as displayed data. 
CSV format When selecting "CSV format", it will save the data in following format.

File type Detail
CSV(with comma:with trigger output)
（*.CSV）

Save data with trigger occurrence 
information

CSV(with comma)（*CSV) without trigger occurrence information
DATA packet:
binary format

When selecting "Binary format", it will save only DATA packet in binary format. Set the 
address/endpoint and save the data.
To save data in the existing file, select "Add to existing file". 
To save data after removing some data on the top/end, input the number of bytes to remove. 

* All above format will be saved either from "whole log data" or "only selected data".

Notice：Exported data cannot be loaded into the USB protocol analyzer software again.
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Menu item Toolbar Shortcut key Function

Add/Delete Mark F9 Mark the selected row with a number. 
Or, delete it.

Mark List/Edit Shift+F9 Shows the table for marks.

Go to the Next Mark F8
Jump to the next mark from the selected 
row with a mark.
Jump to the first mark of the row below if 
the selected row does not have any mark.

Go to the Specified 
Mark Shift+F8 Jump to the specified mark. Selecting 

this menu displays the table for marks.

Jump to triger position Ctrl+F8 
Jump to the transaction that has trigger 
mark. When it has the plural marks,  
jumps in  order of  trigger mark from 
"1" whenever Ctrl+F8  is pressed.

Jump to next VBus 
voltage/current F7

T h e  f o c u s  j u m p s  t o  t h e  n e x t 
VBus voltage and current. (Jump 
downwardly)

Jump to previous VBus 
voltage/current Shift+F7 The focus jumps to the previous VBus 

voltage and current. (Jump upwardly)

Find Ctrl+F Find packets based under the specific 
conditions.(More Information).

Find Next F3 
Find packets  under the previous 
conditions downward. 

Find Previous Shift+F3 
Find packets  under the previous 
conditions upward.

Device Class Setting
Select the device class setting for the 
translation display.
Use this feature when you have no 
emulation information in the recorded log.

Add Comment Insert the comment to the log file.

Display Filter / Color

Sets the display methods for log data.
Has filter which displays or hides 
specific packets and transactions; font 
which sets display font; color which 
sets color for character or background.

Add Filtering setup 
dialog

In this dialog, you can check/select the 
settings which are previously set in the 
instant filtering function.

Add Filtering setup 
dialog

In this dialog, you can check/select the 
settings which are previously set in the 
instant filtering function.

Instant Device 
Information

If you select the transaction, appropriate 
device information will be displayed.

(Log Window List)  Switch over to another log window.

VBusMeasurementbar Displays or hides the VBusMeasurementbar.
Status bar Displays or hides the status bar.



38

14.　UNINSTALL
1．From the Windows settings screen

In case of Windows 10, open "Apps" at the setting screen from the window panel.
Select "Apps & features" from the application list, and then select "USB Protocol Analyzer 
LE-650H2" from the list.
Press "Uninstall" to uninstall.

2．From the Windows Control Panel
You can also uninstall the program by clicking "Uninstall" of "USB Protocol Analyzer LE-
650H2" (folder name where the program is installed) in "Programs and Features" from the 
"All control Panel Items" item.
* The procedure is the same for Windows 7, Windows 8.1, and Windows 10.

Start (Space)

Start logging data.
Select the normal , repeat mode, or 
VBus Logger mode.
Also, jump to "Log setting" from here 
and set each setting such as real time 
filter , trigger setting and VBus Logger 
mode 

Stop (Space) Stop logging data.

Setup
・Basic setting about log operation 
・Setting about real time filter 
・Setting about trigger setting 
・Setting about VBus Logger Mode 

Help F1
Display this Help file.
*You can also install it using an 

external CD drive, but here we will 
explain other methods.

Version Information Display the current version of Software 
and its revision histories.



39

15.　Specifications

Model LE-650H2 LE-650H2-A

Standard USB2.0/1.1
HIGH（480Mbps)/FULL（12Mbps)/LOW（1.5Mbps)Automatically detect and run

Storage
Capacity

Analyzer  Capture memory 128MB

PC HDD/SSD: Max.10GB 
(Can be specified every 1MB)

HDD/SSD:  Max .40GB (Can  be 
specified every 1MB)

Recording Method
Record USB packets, device status*1 (Bus Reset, Suspend, Disconnect, Device 
Chirp, Hub Chirp, VBUS value) on the HDD/SDD of the PC through the 
capture memory of LE-650H2 (can record multiple log files continuously).

Time Stamp Records timestamps along with USB packets and External input trigger log.
16.7ns for 5 hours max., then start from 0 again.

Packets SOF, IN, OUT, SEUP, DATA0, DATA1, DATA2, ACK, NAK, STALL, PRE, 
PING, MDATA, SPLIT, ERR, NYET, Unknown.

Speed Display Display communication speed per transaction in HS, FS or LS.

Filter
Log Record (or do not record) SOF, IN-NAK, OUT-NAK, SETUP-NAK, PING 

with or without multiple particular address/end points.

Display Display (or do not display) SOF, IN-NAK, OUT-NAK, SETUP-NAK, PING 
with or without multiple particular address/end points.

Trigger

Condition
Particular address/end points, packet type (Token/ Hand shake packets in combination), 
errors (CRC/ PID), data packets (8byte max, Hex/Decimal/Binary or character input, 
with or without bit mask.) and bus state (Bus Reset, Suspend, Disconnect), external 
trigger (edge or level specification possible), VBUS voltage and current.

Action Possible to specify actions enable with log stop, and external trigger output (with 
or without levels or pulses) in sequence (up to 16 sequence).

External 4 external trigger input (TTL level) and 4 external trigger output (LVTTL level).
Connector: 10pin male (2.54mm pitch 961210-5604 or equivalent)

Search Function

SOF, IN, OUT, SETUP, PING, ACK, NAK, STALL, NYET, ERR, idle 
status more than specified value, error (CRC, PID, DATA toggle sequence, 
transaction structure), Mass Storage (SCSI, ATAPI, SFF-8070i), PTP/
MTP, Audio, HID, HUB, Printer, Video, Communication, USBTMC 
class command, unknown log information, specific address/end points in 
combination, standard request, data search (Hex/Decimal/Binary, character), 
trigger point, mark.

Color Display Customization Packets can be color-coded separated.

Detailed Display

Standard requests,  peculiar device requests to HUB/HID/Audio/
Communication/Mass Storage (Bulk Only Transport)/Printer/USBTMC/
Video/Wireless controller Class-Specific device request(only for HCI protocol 
for Bluetooth dongle) class, standard descriptors, each descriptors in HUB/
HID/Audio/Printer/USBTMC/Communication/Video class, command of Mass 
Storage/Bulk Only Transport (SCSI transparent command set, supporting SFF-
8070i), Operations of MTP/PTP, Responses, events, commands and events of 
HCI protocol for Bluetooth dongle, class can be displayed in detail.

Mark/Jump function Up to 99 marks can be set (Able to make comments on each mark)
Statistic analysis 
function

The total number of transactions, transfer bytes, and the average transfer 
rate of specified data for each address/end point.
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VBUS Measurement 
Accuracy

Voltage: range 0 to 8V, Accuracy ±1%FS
Current: range -0.9A*2 to 1A, Accuracy ±1%FS

VBus measurement 
Bar

Display (or do not display) VBus measurement Bar.

VBus 
logger 
mode

Measurement 
Cycle

100ms - 1s (4 steps) 0.1ms – 1s (13 steps)

Storage
 Capacity

HDD/SSD: Max.2GB
*Automatically stop measurement on getting the data of 400,000,000 
sampling(2Gbytes) from the beginning of measurement.

Graph
 display

Display voltage, current, and power consumption in graph at real time.

Dump 
display

Display voltage, current, and power consumption in dump display at 
real time.

Save Save log file data, export in text/CSV/binary for data payload, copy/
paste via a clipboard. (Able to make comments on saved data.)
*VBus logger mode has only the function of saving log files and CSV 
outputting.

Print function Specified ranges of recorded data can be printed.
*VBus logger mode does not have this function.

Measurement port USB standard A/B receptacle: 1 each
USB2.0 port USB standard B receptacle, Connect to the analysis PC
LED Indicator 2-colored LED, POWER/RUN, VBUS, DATA, SPEED (High:red, 

Full:green)
Power Supply USB Bus power (current consumption: 400mA max)
Ambient Temperature In operation: 0 to 40°C

In storage: -20 to 60°C
Ambient Humidity In operation: 20 to 80%RH

In storage: 20 to 85%RH (No condensation)
Standard CE(class A)
Dimensions, weight 86(W)×130(D)×30(H)mm, approx.210g
System Requirement OS: Windows® 7(32/64bit)/8.1(32/64bit)/10(32/64bit) (Japanese/

English Windows®)
CPU: Recommend to use upper model than "Core i series"
RAM: More than 1GB. USB port: USB2.0
Additional Memory: HDD or SSD. 30MB plus enough capacity to 
record log data.

*1: Bus Reset, Suspend, Disconnect are recorded under the following condition.
Bus Reset The SEO status of D+/D- signals is detected within a range between 2.5us and 139.8ms
Suspend A non-communication period not in the SEO status is detected for 3ms or over.
Disconnect The SEO status of D+/D- signals is detected for 139.8ms or over.

Note: The USB device status may not coincide with the actual bus state of the applicable device at the time of 
USB cable connection or disconnection because the D+/D- signals will be unstable.

*2: Display a minus value when VBUS current flows from the device to the host.
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16.  Warranty and after-sales service

Warranty

 ■ When you face any problems 
Please contact LINEEYE distributors or LINEEYE.

 ■  The warranty card is
The warranty card his attached to this product. Please confirm its description and keep it in the 
safe place.

User Registration

For after service and other information, please register your product in our Website. ( https://
www.lineeye.com )

Repair

 ■ If the contents of this manual do not help and solve the problem, please contact us in detail.

　Model 　Le-650H2 or LE-650H2-A
　Serial Number 　8 digit numbers
　Purchase Date 　Year, Month, Day
　Details of malfunction 　As detailed and specific as possible

 ■  Repair within the warranty
LINEEYE repairs, following the repair regulations. Please provide the details of malfunction.

 ■ Repair after the warranty
LINEEYE will repair the products at your own expense.

After Support

Read “FAQ” in our Website or email us.Please refer to “FAQ”. We also have support by email 
regarding the technical issue. When you use it, please register your product via our website.

Version up

You can update the version free of charge from our HP for 1 year after purchase. For the 
product which passed the 1 year you can update it for a fee.(Please make user registration 
when upgrading the version.)

Warranty period : 1 year from the date of shipment from LINEEYE
(It does not include software contents)
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           Phone: 81-75-693-0161        Fax: 81-75-693-0163

     URL  https://www.lineeye.com    Email :info@lineeye.co.jp
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LINE EYE CO., LTD.

There is a registration page on our web site.

( https://www.lineeye.com )

Please register your product for further support.

We will provide you the firmware update information 

and sales information etc.


